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The information described in this document is the exclusive intellectual property of
Nuvoton Technology Corporation and shall not be reproduced without permission from Nuvoton.

Nuvoton is providing this document only for reference purposes of NuMicro™ microcontroller based system design.
Nuvoton assumes no responsibility for errors or omissions.

All data and specifications are subject to change without notice.

For additional information or questions, please contact: Nuvoton Technology Corporation.
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1 Overview

1.1 Introduction

NuMicro Cortex-M IAR Driver allows IAR Embedded Workbench (EWARM) to
communicate with Nuvoton on-chip debug logic.

In-system flash memory programming integrated into the driver allows the user to
rapidly update target code. The IAR Embedded Workbench can be used to start and
stop program execution, set breakpoints, check variables, inspect and modify
memory contents, and single-step through programs to run your actual target
hardware.

This document describes how to install and use NuMicro Cortex-M IAR Driver with
programs written using IAR’s compiling and flash tools.

1.2 Features

Nu-Link driver supports the following features. Some functions are triggered by IAR
EWARM. The usage of these functions can be found in the IAR EWARM User Guide.

® Erase/program/verify Nuvoton chips. (via flash algorithm of Nu-Link IAR driver)
® Easy registers access of Nuvoton chips. (via the .ddf file of Nu-Link IAR driver)
® Support Hardware/Software/Flash breakpoints.

® Support Data breakpoints.

® Support Live Watch.

® Support various configurations for connection. (Reset options, SWD clock, etc.)

1.3 Supported Devices
Click to open the table of supported devices: Link of Supported devices.
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2 Installing Nu-Link IAR Driver

2.1 System Requirements

® Software: IAR Embedded Workbench (EWARM 6.1 and higher version)

® Hardware: Nu-Link ICE Adapter.

2.2 Installation

Click installer file Nu-Link_IAR_Driver.exe.

The delivered package contains a complete set of files. The user needs to run
NuMicro Cortex-M IAR EWARM Driver with C-Spy interface. The following directories
and files can be found after package is installed successfully:

® .\Samples: The sample project that uses Nu-Link driver for IAR.

® \Nu-Link-IAR.dIl: The driver DLL.
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3 Example — Create and Debug a Project

3.1 Start a New Project

This section describes how to start a new project based on NUC100 series chips.
The fast and easy way to start a new project is open an existing IAR project. To
make sure the user knows about all the steps to create an IAR project, this section
will start with an empty project.

1. Open IAR Embedded Workbench, and click “File” 2> “New” - “Workspace”.
ESEE=)

/2 1AR Embedded Workbanch IDE C=8

File| Edit View Project Tools Window Help
New , File GN | 4SS ET e & &
Open » Workspace f) v %
Cloze
Save Workspace

Close Workspace

Save Ctrl+5
Save As...
Save All

Page Setup...
Print... Ctrl+P

Recent Files 4

Recent Workspaces k

Exit
Create a new Workspace e
Figure 3-1 Create a New Workspace
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2. Create a new project by clicking “Project"” > “Create New Project”.
& 1AR Embedded Workbench IDE 228

File Edit View [Project| Tools Window Help

‘D G| AddFiles. vyl er d
Workspace Add Group... f) v x
[ Import File List...

Files Add Project Connection...
Edit Configurations...

Remove

Create New Project... h
Add Existing Project...

Options... Alt+F7
Version Control System >

Make F7
Compile Ctrl+F7
Rebuild All

Clean

Batch build... F&

Stop Build Ctrl+Break I

Figure 3-2 Create a New Project

Create a new projed

3. Select “ARM” as the tool chain for this project, and then click “OK”.

i B!
& 1R Embedded Workbench IDE [=/@] % ]
File Edit View Project Tools Window Help
D@ @ S T B &P dbh
Workspace fl - x
Tadl chain 4R NT 1
Files J Project templates:
- Empty project
(- asm
[ G+
e
- Entemally built executable
Drezcription:
Creates an empty project.
[ 0K ] [ Cancel
Ready
.

Figure 3-3 Select the Tool Chain for the Project
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4. Now you’ll be prompted to save the project. Select a folder and input a project
name to save it.

- —
£ Save As — -
ey e S — ese——
v my_iar_project 2 | +5 || Search my_iar_project pol
- _:’_ ~
Organize + Mew folder == - 9
ﬁ Favorites MName . Date modified Type
Mo items match your search,
[ Libraries
i) Computer
e'! Metwork
4 m 3
File name: w v|
Save as type: ’ Project Files (*.ewp) hd ]
(2 Hide Folders | save EE] | Cancel |

Figure 3-4 Save a Project

5. After the project is saved, right click on the project name of workspace area, and
click “Options” to open the option setting form.

9 IAR Embedded Workbench IDE E=EET)
File Edit View Project Simulator Toels Window Help
D@ & bR o AR ER P dEHh
Workspace = ) - x
Debug -
Files oo
@|hellowosld-_L .+
Options... I}
Make
Compile
Rebuild All
Clean
Stop Build
Add 3
Remaove
Rename...
Version Control System ]
I heloworld
Open Containing Folder...
Edit options for th File Properties... 3

Figure 3-5 Open Project Options Form
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Cateqgory:

5

C/C++ Compiler
Assembler

Output Converter Target | Qutput | Library Configuration | Library Options | MISRAC.200- * | »

Custom Build
Build Actions
Linker
Debugger @ Core ARMTTOMI -
Simulator —
Angel () Device | None | |t|"|
CMSIS DAP o
GDB Server

TAR. ROM-monitor §
IHet/TTAGjet Endian mode FPU

TI Stellaris () Big

Macraigor @ BER2

PE micro

REI BEB
STLINK
Third-Party Driver

I hellowarl) TI ¥DS100

Ready l 0K I[ Canesl ]
[ —

Processor variant

Figure 3-6 Options Form

6. The default options are neither for NUC100 series nor for Cortex-MO0. Check the
“Device” option and click the “Device” icon on the right to select the correct
device name, such as “Nuvoton NUC100AN series (NUC100AN,NUC120AN)”.

”
—— Options for node "helloworld” u

Categorny:

General Options
C/C++ Compiler
A HI

Output Converter Target | Qutput | Library Configuration | Library Options | MISRA-C:200/ « [ |
Custom Build
Build Actions
Linker
Debugger (@) Core |Cortex—MD - |
Simulator -

Angel @ Device  Muvoton NUC10DAN series (NUCT! [%

Processor variant

CMSIS DAP

GDE Server

IAR ROM-monitor
IHet/TTAGjet Endian mode FPU

IHink/I-Trace @ Little None |
T1 Stellaris Big

Macr.aigor BE?

EE;" e @ BES

ST-LINK
Third-Party Driver
TIXD5100

hellowol

Ready
S—

Figure 3-7 Select Target Devices
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7. To link and run the program in flash memory, override the default link script for
this project. In this example, simply specify the link script used in the sample
project “Samples\PWM”.

»
o~ Options for node "helloworld” ﬂ
& IAR Em

File Edi

L= Calegoy: Factory Settings
Workspace General Options
[Debug ] C/C++ Compiler
Assembler
Fileg Output Converter Cenfig | Library | Input | Optimizations | Advanced | Output | Lst | +]*
) I Custom Build

Build Actions Linker corfiguration file

L= Overide defaul

Debuagger
Simulator ake_IARNSamples\NUC140_PWM corfighNUC140_Hash icf @
Angel

CMSIS DAP

GOB Server

IAR ROM-monitor Corfiguration file symbal definitions: {gne per ling)

I4et/ITAGjet ‘/

Iink/3-Trace

T Stellaris C:\Prpgram FilesiNuvoton Tools\Nu-Link_lAR\Samples\PWM\config\NUC

Macraigor

PE micro

RDI

STIMNK

Third-Farty Driver

TI XDS5100

-~

I hellowal

Ready [ ok ][ Ccanesl |
[Se—

Figure 3-8 Select Linker Configuration File

(Note: 8051 series uses .xc file)
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8. Select “Nu-Link” as the debugger driver for this project. On the “Debugger” page,
select “Third-Party Driver”; and on the “Third-Party Driver” page, fill in the path
of Nu_Link-IAR.dII.

F
o Options for nede "helloworld™ u
& AR Eny '
File Edi
3 ~ .
] O = ||| Categoy Factory Settings
General Options
Debug C/C++ Compiler
Assembler
Files Output Converter Setup | Download | Images | Extra Options I Pluginsl
) I Custom Build
Build Actions Driver Run to
Linker Third-Farty Driver - main
(TwiPery Drver )
Simulator Angel
Angel CMSIS DAP
CMSIS DAP GDB Server | 0
GLB Server ::Jog{ ,-’JH'[I:') ﬁh('la-}';onrtor =
IAR ROM-monitor J-Link/J-Trace -]
I-jet/ITAGet Tl Stellaris -
Iinkf1-Trace MEIC!T.:Iigol'
I Stellaris PE micro
Macrai RDI
scraigor ST-LINK -
PEmiro v oy e 0
ROI TI XD5100 | -
STLINK
Third-Party Driver
I hellovar] | TIXDS100
Ready
—

Figure 3-9 Select Debugger Driver

'g@ AR i Options for node "helloworld” | D Pl

File §

D& ooy : 4 B
i Factary Settings
[ - X

General Options
Debug C/C++ Compiler
. Assembler
Files ’ 3
) Output Converter ‘Third-Party Driver
ﬁn Custom Build
Build Actions

|IAR debugger driver plugin

Linker
Debugger C:\Program Files"\Nuvoton ToolsWNu-Link_IAR\Nu-Link_|AR.dll %

Simulator

Angel

CMSIS DAP

GDE Server

IAR. ROM-monitor
I4jet/ITAGjet
J-Linkf1-Trace

TI Stellaris
Macraigor

PE micro [T Log commurnication

RDI |SPROJ_DIRS"-J::swcomm.Iog | ||
ST-LINK —
[ helo

TIXD5100

Ready [ oK ][ Cancel ]

Figure 3-10 Use Nu-Link for Debugger Driver
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9. Go back to the “Debugger” page, click the “Download” tab and enable the “Use
flash loader(s)”. If the previous settings are correct, the default load file should
be “6TOOLKIT_DIR$\config\flashloader\Nuvoton\NUC100_APROM.board”.

Options for node "helloworld” ﬁ
8 1AR Eny
File Edif
D& || Cu
\@ General Options
Debug C/C++ Compiler
Assembler
Files Output Converter Setup | Download | Images | Extra Options | F‘Iuginsl
ﬂml Custom Evild [T Attach to running target
Build Actions
Linker [ Verify dowrload
[ Suppress download
Simulator
Angel e flash loader(z)
CMSIS DAP .«‘i Overmide defautt board file
GDB Server STOOLKIT_DIRS'corfig'lashloader\Nuvatom\NUCT| [
TAR. ROM-monitor
IHet/TTAGjet Edit...
IHink/-Trace
TI Stellaris
Macraigor
PE micro
RDI
STLINK
Third-Party Driver
hellowar TI ¥DS100
Ready [ Ok ] [ Cancel ]

Figure 3-11 Select “Use flash loader” Options
(Note: 8051 series do not need to set flash loader)

10. After the option settings are done, click the “OK” button and save the project.

Since the project is initially empty and has no source code, an ASM startup code is
required for a Cortex-M project. Simply copy the file “cstartup_M.s" from the
installation folder of Nu-Link driver to the project’s directory.

To build the project, you should add the startup code and user application code to
the project. Please follow the steps below:

Apr. 2, 2019 13 Rev. 2.07
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1. Add the cstartup_M.s to the project.
The default path of the startup ASM is:
"C:\Program Files (x86)\Nuvoton Tools\Nu-
Link_IAR\Samples\NUC140_PWNM\cstartup_M.s"
(Nuvoton BSP for IAR project uses file startup_seriesName.s as the startup ASM
file, which has the same functions as cstartup_M.s).

/& IAR Embedded Workbench IDE @ﬂﬁ

File Edit View Project Mu-Link Tools Window Help

inﬁnﬁlélééa],lﬂﬂl e e dh

Workspae = 0 v x

Debug -

Files in B

[ Jhelloworld -] &

Options..

Make
Compile
Rebuild All

Clean

Stop Build

Add v " Add Files... N

Remove Add Group...

Rename...

Version Control System 4

I hellovarld

Add one or more files to 4

Open Containing Folder...

File Properties...

Figure 3-12 Add Files to the Project

& 1AR Embedded Workbench IDE BEl

File Edit View Project Nu-Link Tools Window Help
DEHE S 2R o vy erdbd
Workspaee x| 0 - x

Debug -

Files B
E (G helloworld - «

PR cotartup_b s -E
1 0utput

hellovarld

C:\Program Files\Nuvoton Tools\Nu-Link_IAR\Samples\NUC140_PWM\cstartup_M.s

Figure 3-13 Add “Cstartup_M.s” File to the Project
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2. Now add the main function to this project. Click “File” > "New” - “File”, and
input the main function in the new file’s editing pane.

. Y
& IAR Embedded Workbench IDE =] B ]
File Edit View Project Mu-Link Tools Window Help
Dwﬂﬁléléﬁhélﬂﬁl MR e - e
Workspace * |l untitled1 * | f) » X
Debug ~ 1  #include <stdio.h> =
RS & | 2 int main (void) I
[=fmihelloworld - -- 4 1
# fh cstartup_h.s 5 printf ("Hello, world!\n");
L@ (7 Output &
7 return 0;
8 1
9
hellovarld P —T— , n
Ready
A
Figure 3-14 Add the Main Function in a New File
3. Click “File” > “Save” to save the new text file as “main.c”.
. Y
3 IAR Embedded Workbench IDE ESRER
File Edit View Project Mu-Link Tools Window Help
Dwnﬁlélr}éhalnnl 4 vYeuEe e dh
Workspace | f) ~ x
Debug - 1 #include <stdic.h> =
Files & by ) ) ) F
E (G helloworld -._. « :nt main(void)
fsmcstartup_h.s *

printf ("Hello, world!\n");

[ ] Cutpout

return O;

W o =] & b W R

m

Ihelloworld PN —T— ol S

Ready

Figure 3-15 Save the New File and Rename to “main.c”
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4. Add “main.c” to the current project. After “main.c” has been added, it will be listed
in the “Workspace” pane.

& IAR Embedded Workbench IDE =] B ]
File Edit View Project Mu-Link Tools Window Help
‘Dwﬂﬁléléﬁhélﬂﬁl Y emER e dh
Workspace | fl - x
Debug e 1  #include <stdio.n> ol
Files o 2 I
3 int i id
E (G helloworld - « 3 :n main(void)
& fshestarup_t.s - . " N
pe—— z printf ("Hello, world!\n");
L@ L3 Qutput - retarn 0
8 }
9
helloworld " = n I.|
Ready

Figure 3-16 Add “main.c” File to the Project

5. Click “File” - “Save Workspace”. In the file dialog, input a name for this
workspace and save it.

] lmdesz [
{g; Save Workspace As g
%l, [ my_lar_pmJect 2 P|
W=i Organize + Mew folder B= - @
Dg =
_F 3 Favorites MName Date modified Type
= .. Debug 2014/1/13 4 06:... File folder
||: || [l Libraries || settings 2014/1/13 T4 06:..  File folder
L
4
N Computer
“ﬂ Metwork
4 1 2
File name: m -
Save as type: ’Workspace Files (*.eww) v]
I_' 4 Hide Folders ’ Save !}J [ Cancel ]
Rea

Figure 3-17 Save the Workspace
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6. Now start to build the project by clicking “Project” - “Rebuild All” or “Make”.
% my_workspace - [AR Embedded Workbench IDE E@g

File Edit View [Project| Nu-Link Tools Windew Help

D HE@|  AddFies. YR EED &G
Workspace Add Group... f) - x
[Debug Import File List... =
Files Add Project Connection... il
= (F helloworl Edit Configurations...
Az cstary
main r: Remave orld!\n");
(3 Outout Create New Project...
Add Existing Project...
Options.. Alt+F7 L
Version Control System >
Make F7
Compile Ctrl+F7
Rebuild All [}
Clean
R Batch build... F& 5 -
Clean and make the Stop Build Ctrl+Break

Figure 3-18 Rebuild the Project

7. The project is created successfully.

& my_workspace - AR Embedded Workbench IDE Elﬂlg
File Edit View Project MNu-Link Tools Window Help
D Hd@ & BR[| AAAAILEE X ]2
Workspace o main.c| f) - x
[DEbUQ '] 1 #include <stdio.h> T'
Files g2 o 2 B ) ) B
=fahelloworld-_ [ v | | j :nt. main(void)
& fshcstartup_M.s . " . |
i, 2 printf("Hello, world!\n"): =
=
L@ (3 Output - return 0;
8 H
Ihelloworld " 3 = ol =
£ .
Messages File L. |+
cetartup_M.s
main.c

Linking w
Total number of errors: 0 H

Total number of warnings: 0

=
3|« 1 | »

Ready Errors0, ¥V .

Figure 3-19 Build the Project Successfully
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3.2 Debug a project

IAR EWARM is a tool for users to debug the project easily. After the project is
created successful and the target device and Nu-Link debugger is correctly
connected. (Note: 8051 series didn’t support the features after section 3.2.1)

® Click “Project” - “Download and Debug” to start to download and debug the
project. Using the project described 3.1, the program will pause at function

main().
r% my_workspace - [AR Embedded Workbench IDE @Elér
File Edit View [Project| Nu-Link Tools Window Help
O W Add Files... -
Workspace Add Group... f) ~x
[Debug Import File List... =
Files Add Project Connection,.. S

=fa]helloworl| Edit Configurations...

fem Cstartup

" 1 LA =
i Remowve brld!\n") ; E
(3 Outout Create Mew Project...
Add Existing Project...
| hellovorld o 2
Options... Alt+F7
x
tessage Version Control System 3 File L. =
cstartup_
main.c Make ki
Linking Compile Ctrl+F7 i
Rebuild All E
Total num
Total num Eleay
= Batch build... F& S
al ‘| | | v
Download the appli Stop Build CtrlsBreak Errors 0, V
—
Download and Debug % Ctrl+D
Debug without Downloading
Make & Restart Debugger Ctrl+R
Rectart Mehianer Chrls Shift+ R

Figure 3-20 Download Code and Debug
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& my_workspace - AR Embedded Workbench IDE =
File Edit View Project Debug Disassembly MNu-Link Tools Window Help
DEHd@ S| B=R|o o Y EEED®E®EH
Clel2a LEL2 X
Workspace x r | ) %
[Debug h 1 #include <stdio.h> T'
Files fn B N 2 K 7
3 int i id
B (T helloworl... « a {n main(void)
& fshostartup_.. . " .
. 2 printf ("Hello, world!'\n"); =
L@ [ Output - retarn 0;
g }
Ihelloworld 4 ° o g 2

Goto v |Memary -

Disassembly | |
nain: U
£ Oxd2c: OxkS80  PUSH  {R7. IR}
=]
§ printf{"Hello, world!-n"j:
ﬁ O=xd2=: 0=4802 I1DR.H RO, ?Ymain_0
& Nwd3N: Nwf?ff Nwffd? BT mrint f i
Ready

Figure 3-21 Pause at Main Function while Debugging
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The following section introduces the debug features using the project described
above.

® Move the cursor to the line that contains “printf’, press “F9” to set a breakpoint,
and then press “F5” to run the program until one breakpoint occurs. Now the
program pauses at the breakpoint line.

& my_workspace - IAR Embedded Workbench IDE @M
File Edit View Project Debug Disassembly MNu-Link Tools Window Help
D@ & & 2alo o YR e dh
Se2a LB B2 X
Workspace x e | f) v %
[Debug '] 1 #include <stdio.h> T'
Files S g b s _d i
= (Fhelloworl... v n :n wain{void)
B estartup_.. L
SIS © s printf ("Hello, world!\n");| -
main.c .
[:IOutput T return 0;
8 }
Ihelloworld PN —T— =l
Goto * |Memarny -
Disassembly Sl
o [
main:
N Oz4Zc: 0Oxb5E0 FPUSH {R7. LR}
E printf{"Hello, world!-n"}:
g Oxd2e: 0=4802 1DR. N RO, ?Ymain_0
i@
(=] - Sk
Ready

Figure 3-22 Pause the Program by Setting Breakpoints
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® Open the “Terminal I1/0” pane by clicking “View” - “Terminal I/O”. Press “F10”
to step over current source line. The printf will output the message in the
“Terminal I/O” pane in a semihosting way.

& my_workspace - AR Embedded Workbench IDE E@g

File Edit Wiew Project Debug Disassembly Mu-Link Tools Window Help

Dl &) BR[0 o YR EH
CleZa £E 2T X
Workspace x mair‘l.c| £ - x Terminal Ij0 ®
[Debug - 2 —1 | Dutput: Log file: O
Files & B 3 int main(void) 1l Hello, world! ~
COtcllowor v g\ pemsEmssm
B Cstartup_.. i =
i *7 IR '
] Oupul g8 |} Inp [ Ctilcodes | [Input Mode... |
9 .
I helloworld r ’E o = Buffer gize: 0

Goto v | Memory -

Dizassemblhy
printf{"Hello, world!-n"}:

BE

OzdZe: 0=4802 1DE. W RO, ?'main_0
© 0=:430: Oxf7E Oxffd2 BL  printf ...
£
&5 return 0;
S o434 ome000  MOVS RO, O
8 LYoy — - e Y= i
Ready

Figure 3-23 Terminal I/O Pane
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® Click “View” = “Memory” to open the Memory pane, in which user can view or
edit the memory on the target device.

% my_workspace - JAR Embedded Workbench IDE @M
File Edit E\f'iew Project Debug Disassembly MNu-Link Tools Window Help
‘D@ E Messages g fryrwemErerdd
: | [ X | Workspace
Workspace Source Browser 3 f) =~ X% Terminal 1O x
Diebug Breakpoints Tl Output; Log file: OFf
) i i | o
Files Disassembly L main(void) n Hzllo. world!
T | Memory brint ("Hello, worldy
fisi i h‘
: Symbelic Memaory i
=t 0: = I b
[ad Register retarn U; 1
Watch 3 Inp [ Clrl codes ] [InputMode...]
I T Locals Buffer size: a
[
< Statics
Goto Auto -
Dis Live Watch o
Quick Watch ) 4
i; ® Macro Quicklaunch LR 150, Femestn (I
ﬁ Call Stack
@
a Stack 3 -
Open a new Terminal ;O

Figure 3-24 Open Memory Pane
% ry_workspace - IAR Embedded Workbench IDE Elﬂlg

File Edit View Project Debug Disassembly Mu-Link Tools Window Help

D& & ¢ ERo o Iy mER 2L b
‘E|‘|537£EEB|X|

Workspace x i | fy %
[Debug 7 3 int main(void) =

Files & mgp - ¢
| [® s printf("Hello, world!\n")j;| ~

B Fhellowo... v ﬂ e

@ A cstarty..

m

: . T ret 07
HE [ main.c * nrn
| AR S B ¥
Ihelloworld " a = ol =
b4
Gota | Memory - E _A_ mnn
oo0o00o0 (20000408 0000048d 0000022f 0000022f -
00000010 | 0000022f 00O00O0Z22f 0000022f OO0O0OOOOO |:|

00000020 | 00000000 00000000 00000000 0000022f
00000030 | 0000022f 00000000 O000022f 0000022f
00000040 | 0000022f 0000022f 0000022f 0000022f
00000050 | 0000022£ 0000022f 0000022f 0000022%
00000060 | 0000022f 0000022f 0000022f 0000022f
= 00000070 o0o00022f 0000022f O0000Z2f 0000022f
2| 00000080 | 0O00022f Q000022f 0000022f 0000022f
= 00000090\ 0000022F 0000022f 00000000 0000022f s

AnAnAn-n ANNNNDAE ANNNNS9E OOnAna 98 oo onon o

View or editor memory in the memory window

Ready

Figure 3-25 Memory Pane
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® Click “View” - “Register” to open the Register pane, in which user can view or
edit the registers on the target device.

N B
& my_workspace - IAR Embedded Workbench IDE E@g
File Edit [\f'iew Project Debug Disassembly MNu-Link Tools Window Help
Dﬁd Messages 4 Y mME R @ dh
= | [ X | Workspace
Workspace Source Browser 4 fo ~ %
Debug Breakpoints hclude <stdio.h> T'
Files Disassembly s in(void) I
main (vel
Eﬂﬂ?“ Memaory
2B symbolcw BeineE ("Hello, verlanan);
ymbolic Memary :
Register
DC 2 L\} return 0;
Watch 3
Locals
Statics 3
Auto
Live Watch
Quick Watch
Macro Quicklaunch
Call Stack
helloworld Stack y B , n
Open a new Terminal ;O
———— N
Figure 3-26 Open Register Pane
. B
& my_workspace - IAR Embedded Workbench IDE Elﬂlg
File Edit View Project Debug Disassembly Mu-Link Tools Window Help
D@ S BR o vy Ee e dbh
SlelZ2a L2 2 X
Workspace x mair‘l.c| f) = x [Register x
Debug - 1 tinclude <stdio.n> —: [Current CPU Reqisters v]
Files & o 2 — |( RO = 0=00000000
3 int main(void) R1 = 0=00000435
2 @helloworl .. v = R2 - 0x20000004
= &hcstartup_.. ® s R3 = 0x00000001
[C) rain.c . R4 = 0=00000001
L@ [ Output RS = 0=00000001
w7 R6 = Ox00000465
g i R7 = 0=x00000000
k] 1 R8 = 0x55000000
3 R9 = 0=x40000020
| 10 = 0=00030201
R11 = 0=z00402000
R12 = 0x90410100
R13 (SP) = O=x20000400
R14 (LR} = O=000002AF
APSR = O=ze0000000
View or edit registers IPSR = 0=z00000000
EPSR = 0=x01000000
Ihelloworld <= =l a) I »
Ready
A

Figure 3-27 Register Pane
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® In the same Register pane, the user can also access registers other than CPU

registers.

B Y
& my_workspace - IAR Embedded Workbench IDE E@g
File Edit View Project Debug Disassembly Mu-Link Tools Window Help
D@ & =R o A YR REP D EH
SleZr LE 22X
Workspace x main.c| f) = x [Register ®
Debug - 1 #include <stdic.hy — [Eunent CPU Registers ']
. = e t CPU Regist -
Files an 2 E;rlileaegisterseglS °  Jg00o
3 int main(void) GCR 0435
2 Fhelloworl... v = s 0004
Gosiarip . ® s R | | ap
Frain.c . CLK oooL
sk oool
B0 0upu % 7 retarn 0; CLm—ics
] 3 12C0
s et o000
o | Puie
|| Pwne (l0020
RTC 0201
SPIO 2000
SPI oioo
SPI2
SPI3 0400
 THADT 02AF
H TMAZ ol
BOT oooao
[FUARTO oooo
hellowarld < & _ | UaRT1 b
— ~_ U&aRT2 |
Ready P52
h 125

Figure 3-28 Select Other Registers

-

% my_workspace - IAR Embedded Workbench IDE

(=B |

File Edit View Project Debug Disassembly MNu-Link Tools Window Help
DS U@ & % B@lo | vy erdd
Sle22LE22 X
Workspace x main.c| f() = x Register x
Debug hd 1 #include <3tdio._‘l [GP ']
Eilos ie B 2 — HGP_GPIOA FPHD = O=FFFFFFFF
3 int main (veid) HIGPF_ GPI0OA OFFD =
B (Fhelloworl... v a ‘ OFFD = 0=0000
nﬁmstadup_... @ s — HIGP_GPIOA_DOUOT = O=z0000FFFF
[ main.c : GP_GPIOA_DMASK = 0x00000000
[:IOutput GP_GPIOA_PINH = 0=0000FFFF
=7 (FEET GP_GPIOA DBEN = 0=x00000000
g } GP_GPIOA_ THD = 0=00000000
9 1 GP_GPIOA_ TENW = 0=z00000000
3 GP_GPIOA_TISRC = 0=x00000000
GP_GPIOB_FPHD = O=FFFFFFFF
GP_GPIOB_OFFD = 0x00000000
GP_GPIOB DOUT = 0x=0000FFFF
GP_GPIOB _DMASK = 0=00000000
GP_GPIOB_FPIN = 0=0000FFFF
GP_GPIOB_DBEN = 0x00000000
GP_GPIOB_IHD = 0=00000000
| HGP_GPIOB_IEN = 0=00000000
Ihelloworld " |—| = E |T| s
Ready

Figure 3-29 Access Other Registers
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3.2.1 Live Watch

Nu-Link supports IAR “Live Watch” function which can periodically update the
static or global variables and display the values in the “Live Watch” pane while
target CPU running.

® |In Debug mode, Select “View” - “Live Watch”, and then drag and drop the
variables you want to observe in the “Live Watch” pane.

mai1.c| mainQ » X Live Watch £
14 —1 | Expression “alue Location Type
~
& 15  int main(void) 0x20000040
165 ¢ __.—-5 <click t
17 static int|EE Lo, —
18
19 for(:rlr)
20 printf ("3d\n", count++); ‘

O 21

22 retarn 0;
23 }

m

dm gl Y 1 G

Figure 3-30 Live Watch Pane

® Right-click on the “Build” window, select “Options” - “Debugger”, and you
can set the update frequency.

SUUTCE S UUE OO Q&D into functions
x B Debugger,
hMessages . @) All functions
BUIldln_g Can"?. - Terminal /O © Functions wih source only
Updating build: : :
Register Filter Update intervals (milliseconds)
Configuration Live watch: 1000
Memory window: 1000

Figure 3-31 Set Live Watch Update Frequency

® Click the “Go” icon, and you can observe the variables. The automatic update
will be performed periodically.

- |8 E2FLEL5|X
= ] S— al| e
s . Lol : . T

14 T Expression = Lereation :

15 int main(void) ——_ 1426

166 ( lick s 1 %;

- 14

17 static int = 0; 1479

18 1430

19 for(:1:) 1431

20 princf ("%d\n", count
O 21 L

22 return 0; 3

Input: Cil codes

23 | 1 e e

olm [ ’ Buffer size:

Figure 3-32 Live Watch Example
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3.2.2 PinView Plug-in

In Debug mode, user can call “NuTool — PinView” from “Nu-Link” 2 “NuTool —
PinView”, and then check the correctness of pin assignment through GUI.

m

. ~
NuTool - PinView S5
-
(= Jro0%[+ ]} -ccc :
Freg: [0.5s ~|| = LEE
* - Bfissnm
----- E oo = PEFFFEREROODPDOREZEZED
EEFEEARSLELLLLE FEEAAS
Wh= DN 0D XS W —i'\.l_l -l
s - EEEEEFE R SR EE R 2
A6 49
A7 HI!?R 48
ref 79 47
AVDD B0 46
FL.0 =ElR1 4!
1 =Ele2 44
2 =HEl83 43
b3 [E=H| R4 42
y.4 [EEE|8ES 41
1 [==H|EG 40
!

NUCL140VE3CN e

ET1_OuUT =092 34

XTi_In =93 EE]
RE: chT‘ == |94 3z
WSS 95 n

vDD a6 a0

BszDAT 97 29 voD33

psaclk o8 a0 veus
eyss o0 27(EE=] PE7
es.0 (=) 1nno . 2n:|u.- PE.A

~~~~~~~~~~~~~~~~~~~~~~~~~
ddddddddddddddd

Figure 3-33 NuTool - PinView

3.2.3 Semihosting

The Nu-Link supports some semihosting functions for user to easily output
messages in IAR EWARM IDE. The default option settings support semihosting
library. As the example project above, printf outputs the message in the
“Terminal I/O” pane.

The only problem in this example is that it lacks the support of outputting
message on real target device. If the program does not run in ICE debug mode,
but run directly in flash memory, it would be halted by function printf.

To solve the problem described above, please follow the steps below:
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1. Open the “C:\Program Files (x86)\Nuvoton Tools\Nu-
Link_IAR\Samples\NUC140_PWM?” directory and copy the following two files
into your project folder:

® SH_retarget.c
® SH_startup_NUC1xx.s
2. Then open your project, and
® Replace retarget.c (if exists) with SH_retarget.c.

® Replace startup_NUC1xx.s or startup_M.s (if exists) with
SH_startup_NUC1xx.s.

3. To reduce the code size, you can undefine the macros in SH_retarget.c to
disable the real UART or semihosting terminal or both.

® #define DEBUG_ENABLE_UART
® #define DEBUG_ENABLE_SEMIHOST
4. Build and run again. Now you can test the semihosting function again.
® |If debugging with Nu-Link:
Select “View” - “Terminal 1/O” to open the “Terminal I/O” pane.

When the program calls printf, it will show messages in the “Terminal 1/0”
pane.

® [f running program in flash directly without the debugger being connected:

When program calls printf, it will show messages in real UART if
DEBUG_ENABLE_UART is defined.
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3.2.4 NuConsole Plug-in

In addition to semihosting, the Nu-Link provides another I/O mechanism without
affecting the target’s real time behavior. By using standard debug port SWD, It
doesn’t need any additional pin or hardware. The only requirement is that the
target application should reserve a buffer space (hereinafter referred to as
InfoBlock) in SRAM in order to store control settings and communicate 1/0 data
between NuConsole and target. To use the NuConsole functions, please follow
the steps below:

1. Open the “C:\Program Files (x86)\Nuvoton Tools\Nu-
Link_IAR\NuConsole_Sample” directory and copy the following files into your
project folder:

® NuConsole.h/.c
® NuConsole_Config.h
® NuConsole_ Retarget.c
2. Set up the project
® Replace retarget.c (if exists) with NuConsole_Retarget.c.

® Add NuConsole.c to the project and include NuConsole.h in the
corresponding files.

3. Configure InfoBlock

® In NuConsole_Config.h, adjust the appropriate size of TX/RX buffers
according to the application requirements and hardware limitation. Also,
the TX buffer can be configured to be blocking or non-blocking.

® Call NuConnsole_Init() function to initialize InfoBlock before doing I/O
operations (e.g. printf()).

4. Enable the “Generate linker map file” option and build the project

® In the linker map “project_name.map” file under “project_path/Debug/List”
directory, find the value of symbol NuConsole_InfoBlock variable
declared in NuConsole.c to get the memory address of InfoBlock.

5. Download and run
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6. In Debug mode, select “Nu-Link” = “NuConsole” to invoke the control dialog.
Set up the address of InfoBlock, and then click the start button to process 1/0
data.

7. Now when you execute the program and run the I/O statements, you can see
debug information in the NuConsole dialog as shown below:

P
MuConsole P
Stop
Hello, Huvoton!
Info Blodk Transmit Text
Enter
Address 0x20000478
Append nothing - Time-gputLimit(s) 5
Expression Yalue Location
— | # MNuConsole_InfoBlock <struct: O=20000478
E <click to add>
=

Figure 3-34 Debug Information in NuConsole Dialog Box
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3.2.5 ETM Trace

To start Embedded Trace Macrocell (ETM) tracing on Nuvoton Cortex®-M4/M23
devices, please connect to the device using the Nu-Link2-Pro with 20-pin connector and
follow the steps below.

1. Configure the NuTrace.
® Select “NuTrace” from “Nu-Link” menu.
® In “Trace Port” select Sync Trace Port with 4 bit data. It is possible to use other
bit sizes but best to use the largest to increase the bandwidth.
® In “Capture Mode”, specify whether trace data is collected before or after a
trigger.
B Trace After: Capture the trace information after the trigger point and stop
capturing when trace buffer is full.
B Trace Before: Capture the most recent trace information before CPU is
stopped.
® Select Trace Enable and ETM Trace Enable.
® Click OK to save the changes.

MuTrace Setup l — | |_ihj
Core Clock:  152.000000 MHz Trace Enable ETM Trace Enable
Capture Mode Timestamps Trace Events

i@ Trace Mter () Trace Befors [] Enable Prescaler: [C] CPI: Cycles per Instruction
[ EXC: Exception overhead

Trace Paort PC Sampling [F] SLEEP: Sleep Cydles
Sync Trace Port with 4-bit Data v] FEEE m [] L5U: Load Store Unit Cycles
[| Periodic  Period: <Disabled: [T FOLD: Folded Instructions
on Data RAN Sample [ EXCTRL: Exception Tracing

ITM Stimulus Ports
3 Port 24 23 Port 16 15 Port g8 7 Port 0

Enable: 00000000 ] (] ] i i ] i i ] i i i (] | [ [ [
Frivilege: (00000000 Port 31.24 [] Port 23..16 [] Port 15.8 [] Port 7.0 [
| Canesl | | ok |

Figure 3-35 Trace Setup with ETM

2.In Setup macros, please insert the script file to initialize the device’s trace pins when
starting the debugger. The following is an example script file.
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Options for node "TIMER_PeriodicINT" S
General Options
Static Analysis
Runtime Chedking
C/C++ Compiler Setup | Download I Images I Extra Options | Multicore | F‘Iuginsl
Assembler
Output Converter Driver Funto
Custom Build Third Party Driver | main
Build Actions
Linker Setup macros
Use macro file(s)
Simulator - .
CADI mpleCode*StdDriver\ TIMER _PerodicINTWARYM480_TF mac B
CMSIS DAP
GDEB Server E]
M480_TP.mac X
1 execUserReset ()
2[4 {
3 _w-riteliemor—;BfZ (0Ox000EEEEE, 0x40000054, “"Memory”):;
4 }

Figure 3-36 Initialize File for Trace Pins

Note: The Nu-Link driver with the version v2.07 or later will automatically setup
the trace pins when starting the debugger. The user does not need to do the
above configuration.

3. After doing above settings, user must start the debugger. In Debug mode, please

select “Nu-Link” = “NuTrace” to invoke the tracing information dialog, and it will
show every single executed instruction in the current application as shown below.
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r B
NuTrace l E] ﬂ
ETM index address opcode instruction source -
ETM #0 0x00001370 480D, LDR RO, [PC, #52]; 0x000013A8 LDR RO, =0x40000100 [l
[ETM #1 0x00001372 2159, MOV{S} R1, #89 LDR R1, =0x359 N
[ETM #2 0x00001374 6001, STR R1, [RO, #0] STR R1, [RO]

ETM #3 0x00001376 2116, MOV{S] R1, #22 LDR R1, =0x16

ETH #4 0x00001378 6001, STR R1, [RO, #0] STR R1, [RO]

ETH #3 0x0000137A 2188, MOV{S}] R1, #136 LDR R1, =0xa8

ETM #6 0x0000137C 6001, STR R1, [RO, #0] STR R1, [RO]

ETM #7 0x0000137E 4808, LDR RO, [PC, #44]; Ox000013AC LDR RO, =0x40000200

BT 48 0x00001380 6841, LDR R1, [RO, #4] LDR R1, [RO,#0x4]

ETM #9 0x00001362 F4414180, ORR R1, R1, #0x00004000 ORR R1, R1, #0x4000

BT #10 0x00001386 6041, STR R1, [RO, #4] STR R1, [RO,#0x4]

ETM #11 0x00001388 4809, LDR RO, [PC, #36]: Ox000013B0 LDR RO, =0x40007000

BT #12 0x0000138A 6841, LDR R1, [RO, #4] LDR R1, [RO,#4]

ETM #13 0x0000138C FO0410102, ORR R1, R1, #0x00000002 ORR R1, R1, 42

[ETM #14 0x00001350 6041, STR R1, [RO, #4] 5TR R1, [RO,#4]

[ETM #15 0x00001392 6841, LDR R1, [RO, #4] LDR R1, [RO,#4]

[ETM #16 0x00001394 F0410104, ORR. R1, R1, #0x00000004 ORR R1, R1, #4

[ETM #17 0x00001398 6041, STR R1, [RO, #4] 5TR R1, [RO,#4]

[ETM #18 0x0000135A 4806, LDR RO, [PC, #24]; 0x000013B4 LDR RO, =SystemInit

[ETM #19 0x0000135C 4780, BELX RO BLX RO

[ETM #20 0x00000CEQ 4816, LDR RO, [PC, #88]; 0x00000DOC SCB->CPACR |= ((3UL << 10%2) |

ETM #21 0x00000CE2 6801, LDR R1, [RO, #0]

ETH #22 0x00000CB4 F4410170, ORR. R1, R1, #0x00F00000

ETH #23 0x00000CES 6001, STR R1, [RO, #0]

ETM #24 0x00000CBA 4815, LDR RO, [PC, #84]; 0x00000D10 FMC->CYCCTL = (FMC->CYCCTL & ~FMC_

ETH #25 0x00000CBC 6801, LDR R1, [RO, #0]

BT #26 0x00000CEE 0909, LSR{S} R1, R1, #4

BT $#27 0x00000CCO 0109, LSL{S} R1, R1, #4

ETM #28 0x00000CC2 FO410108, ORR R1, R1, #0x00000008

BT #29 0x00000CC6E 6001, STR R1, [RO, #0] o

< | m | *
%

Figure 3-37 Tracing Information Dialog
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3.2.6 LCDView Plug-in

In Debug mode, user can call “NuTool — LCDView” from “Nu-Link” - “NuTool —
LCDView”. For details, please refer to the following link to the user manual:

https://www.nuvoton.com/resource-
download.jsp?tp GUID=UG1320220524115039

NuTool - LCDView - O X
Project Name -~ nuvoTon »
v1.04.0000
Create Mode Emulator Mode

BHE 2 @

Width: [1000 px
Height: 500 px m
[] Show grid
|PrROJ_M258 [v]
|m254sD32E [v]
PID: M2345D3AE
O 7~
I 71 v

‘3)) :|||} [o— +
Icon ID: Path ID:
_.. V Com: Seg: Address: bit:
— +> [Coordinate] Top-Left: Top-Right: Bottom-Left: Bottom-Right:
e
AWBE
— . 4

] sao [ st | s | sa3 | seet | sws | sess | 57 ||
%ppmocoF SN 1 ] T 7 7 ]
Figure 3-38 NuTool - LCDView

[ con1 | H || \I || \I || [
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4 Firmware Update

When trying to debug a project using IAR EWARM, it will check the firmware version
first. If the current firmware version is not consistent with the installed Nu-Link IAR

Driver, a dialog box will pop up as follows:
% my_workspace - JAR Embedded Workbench IDE [

ETE

File Edit View Project Mu-Link Tools Window Help

LI e AN EE e P

LSRR TarldePm - ' 0 - %
[Debug —
Files . Application internal version is not matched! F
E F hellowo $
feth Cstarty Current application has higher version 6211, 1
Frain.c whilethe_ Nu_-Linkfirmware'sversion is 6103, E
DOutput The application may work abnormally.

Before updating the Mu-Link firmware, please
1. Remove any other devices connected on the Nu-Link;

I hielloworld 2. Plug out the Nu-Link, press the keypad on it and plug it into PC I k(=

x again.
Message| L
Building 4/ Do you want to update the Nu-Link firmware now?
Updating/|
Canfigurdl| Yes %J [ No
—
=]
2 Buid [DebuglLog =
Ready Errors 0, V

Figure 4-1 Firmware Update Selection Dialog Box

Click “Yes” to update firmware or click “No” to cancel.
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% my_workspace - IAR Embeddad Workbench IDE | = | = P |
File Edit View Project Mu-Link Tools Window Help
DwHd@ &S| BR| o o S EED P d
Workspace = main.c| ) = x
[DEbUQ hd 1 #include «<stdio.h> _"
Filas i oy z B ) ) I
g BhE"DrP'ld — ) int main (void)
| G caf Nu-Link - - (o L
m 3
Lao
Verify 45%:
Ihellowolld ol <
o
Mes
Build
Updating build tree...
Configuration is up-to-date.
=]
2 Build [DebugLog x
Ready Errors 0, V

Figure 4-2 Updating Firmware

When update is complete, it is necessary to recreate a connection between Nu-Link
and PC. Please plug out the Nu-Link from PC and plug in again.

% my_workspace - IAR Embeddad Workbench IDE

HPEEEE)

File Edit View Project Mu-Link Toels Window Help
D@ & 2R o VYR ER &P @
Workspace = main.cl ) = x
[DEbUQ hd 1 #include «<stdio.h> _"
Filas i oy z B ) ) T
E Fhelloworld -« S ot main (vold) .
Az oSt Mu-Link . e L
Mg 3
L@ (7 0u
Please remove any device on the Mu-Link, and plug out the Mu-Link from PC and plug in
again!
Ihellowolld ol =
« — — |
Messg L.
S —— e 4
Updating build tree...
Configuration is up-to-date.
=
2 Buid [DebugLog x
Ready Errors 0, V

Figure 4-3 Re-connect Nu-Link to Complete Firmware Update
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& my_workspace - IAR Embedded Workbench IDE |ﬂ
File Edit View Project Mu-Link Tools Window Help

D@ & % BR|o o e EED P dEh
Workspace = main.cl R
|Debug *|[T T #inciude <staio.n> =

Files gz By 2 r

: 3 ig larddePm Ml
E Fhelloworld - v

fam st Nu-Link -
ma
L@ (7 0u

m

Update firmware, OK!

Update 100%

[ eloword
s F -
o
tess L.
Bulildliieg cormoprrommen: remererss Sy
Updating build tree...
Configuration is up-to-date.
=
2 Build [DebugLog 3
Ready Errors 0, V

Figure 4-4 Update Firmware Completely

If you use Nu-Link2 adapter, you can also use drag and drop to upgrade firmware.
Press the button on Nu-Link2 adapter and plug in USB cable, you will see a disk name
“Nu-Link2”. Drag and drop bin file into it will upgrade Nu-Link2 firmware. (Note: if you

see disk name “NuMicro MCU?” it will upgrade the target device firmware instead of Nu-
Link2 itself.)
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5 Revision History

Revision Date Description

1.02 2010/07/07 Added the IAR’s project settings.

1.03 2010/07/22 Added the M05x series.

1.17 2011/08/12 Used new configuration for NUC100 series.

1.18 2013/07/01 Added the “Nuvoton Announcement” and “Firmware Update”
chapters.

1.19 2014/02/24 Changed document format, and updated all figures.

1.20 2014/10/17 Changed document and figure format.

2.01 2017/02/23 Added the “NuConsole” chapter.

2.07 2019/04/02 Added the “ETM Trace” chapter.

Notice: Using this software indicates your acceptance of the disclaimer hereunder:

THIS SOFTWARE IS FOR YOUR REFERENCE ONLY AND PROVIDED "AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. YOUR USING THIS SOFTWARE/FIRMWARE IS BASED ON YOUR OWN
DISCRETION, IN NO EVENT SHALL THE COPYRIGHT OWNER OR PROVIDER BE LIABLE TO ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Flease note that all data and specifications are subject to change without notice.
All the trademarks of products and companies mentioned in this datasheet belong to their respective owners.
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